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1. Introduction 

The process of data acquisition via oscilloscope is a frequent undertaking at the U.S. Army 
Research Laboratory (ARL) aeroballistics facilities.  The acquired data is typically saved to  
3.5-in floppy disks using oscilloscope menu buttons, and, in turn, the floppy disks are transferred 
to a personal computer for processing and analysis.  The procedure becomes more repetitious, 
time-consuming, and error-prone as more channels of data are sought.  

The analysis software package Nicolet Proview1 was recently implemented on a trial basis as a 
user interface for data acquisition at the ARL Aerodynamics Experimental Facility during an 
aeroballistics experiment.  This Windows-based software was successfully used for simultaneous 
data triggering, acquisition, and transfer between three Nicolet Integra 10 oscilloscopes and a 
laptop computer running a Windows 98 operating system.  More recently, Proview was also 
successfully loaded and tested on a laptop computer running a Windows 2000 operating system. 

A typical data recording process with each of the four channels of the Integra 10 configured for 
its highest number of data points possible (10K) would use 6 kB (kilobytes of memory) for setup 
and 22 kB per channel, adding to 94 kB of memory used per floppy disk.  This limits the 
recording process to 16 tests per floppy as 1.5 MB is the limit storage capacity for a typical 
floppy disk with no high density. 

By using only high-density types, i.e., 2 or 3 MB, the recordings could increase to 21 or more.  
Still, the time-consuming process of reformatting each floppy disk previous to the data 
acquisition process is a must, as it decreases the chance of losing data due to unknown disk 
density.  Also, as the Integra 10 menu does not display the true size of the files saved to disk or if 
not enough disk space was available to save the last file, the status of the data saved to the floppy 
remains unknown until checked on DOS or Windows, not available on the unit.  

The objective of this report is then to describe the step-by-step procedures used to set up and 
control the data acquisition process using Proview as a user interface.  Such a description is 
valuable because the Proview software support guides do not sufficiently address the basic 
aspects of such a system implementation.  This guide will prevent future users of the system 
from having to readdress the same interface problems that were solved during this initial effort.  

The list of the hardware and software involved to get the Proview program to work is as follows:   

1. PCIB-GPIB card with latching cable, 

2. Nicolet hardlock memory key installed into the PC parallel printer port, 

                                                 
1 Proview; Nicolet analysis and report software; Nicolet Instruments Technologies Inc.:  Madison, WI. 
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3. Proview Version 3.4, 

4. National Instruments NI-488.2 for Windows software, 

5. Integra Control software version 1.4.4, and  

6. PC Utilities software version 1.9. 

1.1 Opening Proview in Windows 

The NI-488.2 National Instruments software works in conjunction with the Integra Control 
software to operate the commands for remote triggering of the oscilloscopes as well as data 
acquisition and its transfer through the IEEE-488 port of the Integra 10 and the GPIB card/port 
of the PC.  After opening Proview, the activation of the Integra Control icon will establish a 
handshake with the oscilloscope(s), which must be powered on in order to avoid a GPIB error 
message.   

While Windows 98 allows to the Proview program to be loaded by just clicking on its icon, 
Windows 2000 prompts for a printer to be connected in series with the hardware memory key.  If 
there is no printer software installed previously in the PC, one must be loaded (i.e., Hewlett 
Packard Laser Jet 2000 or newer).  Otherwise, an error message will prompt that the memory key 
is not installed.  

To avoid this error message once a printer software is available in Windows, access the Start 
menu followed by left clicking on Settings, then Printers; right click on the printer’s logo; right 
click again on Properties; and select Print Test Page.  “OK” the printing of the test page and 
cancel the prompt that reads “There was an error found while printing the document Test Page to 
LPT1.” 

After that, close all the windows opened during the printer’s sequence; power on the 
oscilloscope(s); and open Proview.  Next, go to File on the Proview menu and select Load 
Settings.  Click on the icon labeled Integra Control to be able to configure each oscilloscope 
address.  

The user can practice to modify and create the proper settings needed for the parameters of a 
particular test requirement, like window length and volts/division per channel through the default 
tutorial setting BETUT.vws.  These settings have to be compatible to the oscilloscope settings to 
avoid data clipping while viewing the transferred data in Proview.  However, data acquired is 
only affected by the settings of the oscilloscope and not the ones selected on Proview.  

For sake of following a preset view, select any *.vws from the menu.  After saving the settings 
the first time, Proview will load them automatically.  The Proview screen will then display four 
channel settings.  Once labeled, the Integra Control icon will display three choices—Hold Next, 
Save Traces, and Abort.  If, however, the oscilloscopes are not on line, the following error 
message will be displayed:  “Integra Control Aborted!  No devices connected to GPIB bus.” 
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The error message is shown in figure 1; the display for the Integra Control in figure 2; and the 
initial Proview view in figure 3.    

 

 
Figure 1.  Integra Control error message. 

 

Figure 2.  Activation of the Integra 
Control icon.  

 

Figure 3.  Loading a View setting in Proview. 

If a particular View setting loaded by default when opening Proview is not needed, open File on 
the Proview menu and select Load Settings.  A list of Viewset files from which to select will be 
displayed on the menu.  Figures 3–5 show the display sequence. 
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Figure 4.  Display of Viewset (*.vws) files.  

 

Figure 5.  Closeup of Load Settings menu. 

1.2 Setting the GPIB Link for the Integra 10 Handshake 

By pressing on the Main button under Menu on the Integra-10 four-channel oscilloscope 
(figure 6), a display of the following Main Menu list of options becomes available: 

1. Acquisition Menu, 

2. Sweep Length Menu, 

3. Trigger Menu, 

4. Time base Menu, 

5. Display Menu, and  

6. Utility Menu. 
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Figure 6.  Integra 10 front panel layout. 

Press/select Utility Menu and select I/O Setup.  The list of options will be displayed as follows: 

1. RS423 Setup 

2. GPIB Setup 

3. Remote Controller: GPIB…RS423 

4. External Plotter : GPIB…RS423…Parallel 

5. Bulk Transfer: Binary…Text 

6. Bulk Word Size: 8Bit…16Bit 

Press/select GPIB Setup by pressing the adjacent right-side button.  The list of options will be 
displayed as follows:  

1. GPIB address: # #… 

2. EOI: OFF…ON 

To input a desired GPIB address, i.e., 14, press the adjacent cursor’s right-side button up and 
down and the left-right cursor buttons at the Integra 10 control panel to select or change the 
digit’s address.  Press the Select Trace/ Enter button to exit this menu. 
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• Press/select highlight EOI: ON 

• Press Return to display previous menu with the six options.  Make the following selections: 

 a.  Press the adjacent side button and select/highlight Parallel. 

 b.  press the adjacent side button and select/highlight Binary. 

 c.  Press the adjacent side button and select/highlight 16Bit. 

 d.  Now repeat this setup on each of the remaining scopes. 

1.3 Selecting the Channel Parameters on Proview  

Selecting View from the Proview menu opens the modify folder and enables the selection of the 
proper window length to accommodate the oscilloscope display.  The display will be transferred 
to the laptop view without display data clipping (figure 7).  The span of the window is selected 
under X-scale either manually by preselecting a minimum and maximum set of values in 
milliseconds under the Fixed mode or automatically by selecting the Auto mode.  The display 
can be selected to be in logarithmic, linear, and X vs. Y scales; there are provisions for a grid 
selection ON or OFF, gridlines, and ticks (figures 8 and 9).  

Figure 7.  Selection of the Modify folder from the View menu. 
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Figure 8.  Selection of window length and display configuration. 

 

Figure 9.  Closeup of View Setup. 

Similarly, by selecting Trace followed by Modify from the Proview menu, it is possible to select 
volts per division, channel ID nomenclature, show zero line, or also set the volts per division to 
be self-adjusting (Auto) according to the data parameters (figures 10–12). 
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Figure 10.  Selection of Modify folder from Trace subdirectory. 

 

Figure 11.  Selection of the Trace nomenclature and volts per division. 
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Figure 12.  Closeup of Trace Setup. 

2. Enabling Handshake With Oscilloscopes via the GPIB Link 

The Integra Control icon (on the right in figures 1 and 13) allows the selection of the port or 
address to be assigned to each oscilloscope set to acquire data.  This process is accomplished by 
clicking on Configure and GPIB consecutively.  

Selecting GPIB will open a list of possible addresses for each oscilloscope that is powered ON 
and connected via the PCIB-GPIB/IEEE-488 link.  The Configure GPIB icon menu will first 
display “14” as the lowest default address allowed and will only scroll to higher addresses 
correlated to the oscilloscopes that are ON.  The PCIB-GPIB card latching cable originated at the 
laptop is the first connection to be made to the IEEE-488 port of the first oscilloscope 
corresponding to the lowest possible address, i.e., 14 (figure 14).  That first oscilloscope must 
have such an address.  All the rest of the addresses chosen as the highlighted number are correct  
(figure 15).  The Configure GPIB window will display only addresses for the oscilloscopes that 
that are ON and GPIB connected. 

All the other connections to the IEEE-488 ports of the rest of the scopes are made from the 
IEEE-488 port of the first scope using GPIB compatible-type cables.  These cables allow the 
successive “plugin” of several connectors at the same port by securing each plug into the 
previous one.  The connections are limited only by the physical limitation imposed when 
connecting each GPIB cable terminal originated at each scope’s IEEE-488 port into the IEEE-
488 port of the first scope. 

Thus, if three oscilloscopes are used, the IEEE-488 port of the first oscilloscope will have the 
PCIB-GPIB card latching cable originated at the laptop connected to it.  Latched to this will be 
the GPIB compatible-type cable connecting its IEEE-488 port to the IEEE-488 port of the second 
oscilloscope and then another GPIB compatible-type cable connecting its IEEE-488 port to the 
IEEE-488 port of the third oscilloscope.  
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Figure 13.  Proview display and Integra Control icon menu. 

   

Figure 14.  Menu options of Integra Control icon.  

  

Figure 15.  Address selections. 

When selecting Autocycle (figure 15), the software will save the transferred *.WFT data files 
from the Integra 10 oscilloscopes into the laptop C drive.  It will save them in a default directory 
(C:/ EXP) where these data files are saved in separate folders with automatic nomenclature 
starting at the first acquisition process by default as “ 00000001” (figure 16).  If Autocycle is not 
selected, it is necessary to previously export the files into a new created directory/folder to 
continue the transfer of any more data into Proview.  
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Figure 16.  Automatic saving of data files. 

2.1 Oscilloscopes Trigger Setup via Integra Control Menu  

The proper command sequence to obtain trigger and data transfer begins by setting all 
oscilloscopes manually on Norm for normal trigger mode and Hold Last (see figure 6).  Next, 
select Configure from the Integra Control icon menu, scroll down and OK the highest port 
address as described previously.  A scope with the assigned address will go to the mode Live and 
Hold Next.  It will briefly display “GPIB ifc,” confirming that the GPIB link is OK, and also 
display the “Waiting For Trigger” prompt.  

It is imperative that after each address configuration, the “Waiting For Trigger” prompt is 
displayed on each oscilloscope’s screen, where the Trigger mode can be Combination, Dual 
Slope, or Edge, according to the way the scope trigger was preset.  

To proceed configuring each port address available in decreasing order, again select Hold Next 
and Configure and OK the port address.  The familiar “GPIB ifc” and “Waiting For Trigger” 
prompts will be displayed, confirming that the oscilloscope is ready for data acquisition. 

Follow the identical sequence until the lowest last address is reached, i.e., 14.  At this point, 
when acknowledging the address selected by left clicking on OK, whatever data displayed on the 
scope screen at this time will be dumped on the laptop’s Proview view and should be 
disregarded.  To reset this last transfer port, again select Hold Next, then configure the port 
address again.  “Waiting For Trigger” will be displayed—all oscilloscopes should display 
“Waiting For Trigger.”  The acquisition system is now ready for acquisition and data transfer. 

As mentioned before, once all scopes have been triggered by the experimental event, data from 
the last scoped configured (lowest port address number) will be automatically transferred first 
into the Proview view.  It should be saved immediately before attempting to transfer the next 
port/scope address data; otherwise, the acquired transferred data will be lost.  

To transfer data from the scope with the next port address, select Hold Next and Configure, 
scroll down its port address, and OK it.  Again, data transfer will occur automatically and be 
displayed on the Proview view, where it must be immediately saved. 

It is very important that the migration to each scope through the Integra Control menu, while in 
the process of data transfer, is done in order and carefully.  A mistake in the calling of the Integra 
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Control sequence can superimpose the Waiting For Trigger prompt on the scope of port address 
involved and disable its data transfer thereafter.  The order of calling the port addresses in 
increasing or decreasing order is determined by which port address is transferred first 
automatically. 

2.2 Saving Data Automatically From the Integra 10 Into a Windows File  

By selecting Autocycle Records and Yes on the Integra icons, as shown in figure 16, the 
acquired data record will be transferred automatically from the oscilloscope and saved into a 
C:/EXP directory created by default during the installing of the Proview software. 

This selection, which can be made while in the process of configuring the first port address, will 
apply to all data acquisition done while the Integra Control is selected.  All the procedures to 
configure the port addresses and setting each oscilloscope ready to trigger are identical for either 
saving data automatically or manually. 

When selecting which Autocycle Records, data acquired on the oscilloscope with the last address 
configured (see figure 16) will be transferred and displayed automatically on the laptop Proview 
window.  It will be saved in the default directory and on a folder with a default eight-digit 
number nomenclature (see figure 17) only in the WFT Nicolet format.  The folder address and 
the file nomenclature will be displayed to the user, as shown in figure 16.  If desired, this folder 
and its contents can then be renamed or moved into a new folder named after the scope ID 
number. However, if the Autocycle Records is not selected, the “transferring ch #” prompt will 
flash anyway.  The “saving record #” prompt will not flash, and no folder with data will be saved 
automatically into the Windows c:/EXP directory.  Data has to then be saved manually into a file 
folder.  The Autocycle Records provides a fail-safe backup of data.  However, the nomenclature 
of the first data file must be identified after the first data transfer in order to be able to identify all 
the others. 

Figure 17 also details the automated sequence displayed in order of occurrence once the 
oscilloscope is triggered.  Figure 18 shows a saved record no. 25 as having been saved 
automatically into the C:/EXP directory. 

2.3 Saving  Transferred Data Manually Into a Windows File 

The previous method can still be left selected and used as a default way of saving all data.  As 
the oscilloscopes are set for the Trigger mode (Combination, Dual Slope, or Edge), each scope’s 
screen will prompt “Waiting For Trigger,” as described in section 2.1. 
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Figure 17.  Sequence detailing steps for automatic data saving (top left to bottom right).  

 
Figure 18.  Automatic nomenclature.  

Having set the last scope for data transfer, again select Hold Next as for all the previous 
oscilloscopes; the familiar “GPIB ifc” and “Waiting For Trigger” will be displayed.  Once all 
scopes have been triggered by the experimental event, data from the last scope configured will be 
transferred into the Proview view automatically.  Save it into a file by selecting Export Data 
from the File menu and creating a directory and a folder. 

Also select a prefix and data format where the data will be saved and later identified.  The usual 
format for the Nicolet files is the WFT format; however, an ASCII format can also be selected.  
Figures 19–21 show the sequence for data transferred from oscilloscope 1.  Files can be also 
saved in ASCII format (figure 22).  Figures 23–26 show the same sequence for oscilloscope 2.  
Keep in mind that any data set can be transferred and displayed on the laptop screen only once. 
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Figure 19.  Exporting oscilloscope 1 transferred data into a Windows file. 

 

Figure 20.  Selecting oscilloscope 1 data format. 
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Figure 21.  Selection of directory.   

  

Figure 22.  Saving transferred data in ASCII format into a Windows file.  

Any tampering with the same port address through the Integra Control Configure or Hold Next 
commands will activate the prompt “Waiting For Trigger” to be displayed on the oscilloscope 
and disable the transfer of the data screen displayed altogether. 

2.4 Saving Transferred Data Simultaneously by Both Methods Into a Windows File 

The only prerequisite is to OK the Autocycle to Disk, as displayed at the GPIB icon in  
figure 16.  When checked, the Autocycle Records under the “Configure” prompt of the Integra 
Control icon will display the first default address, which can be accepted or not, but cannot be 
changed.  The transferred data can also then be saved into a folder manually by selecting Export 
Data from the File menu and creating a directory and a folder, as explained in section 2.3. 
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Figure 23.  Data transferring from oscilloscope 2 address “15” to laptop. 

 

Figure 24.  Exporting oscilloscope 2 transferred data into a Windows file.  
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Figure 25.  Selection of oscilloscope 2 data format. 

  

Figure 26.  Exporting oscilloscope 2 transferred data into a Windows file. 

Care should be taken by writing down the first default address provided by the “Autocycle” 
prompt so that each following saved file can be identified and renamed to provide the desired 
data backup.  Figure 22 shows a file folder labeled “00000087” on which data has been saved 
automatically as a backup through the Autocycle Records, which are the WFT formatted files, 
and the TXT ASCII files saved manually into the same directory. 

2.5 Display of Saved Data Files Using View *WFT Version 1.2 

An immediate display of the saved WFT formatted files can be obtained by opening the 
View_WFT…. icon.  This allows the data transferred from any oscilloscope to be checked.  A 
step by-step procedure is shown in figures 27–30, where channels 1 and 3 of the Oscilloscope 1  
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Figure 27.  Viewing *WFT data from saved data. 

 

 

Figure 28.  Selecting files to recall from Scope 1 folder. 

folder and channel 4 of the Oscilloscope 2 folder have been recalled (figures 31 and 32).  The 
cursor control as well as the Hexp and Vexp controls allows the cursor to be moved or the 
displayed data to be zoomed. 

2.6 Conversion of WFT Formatted Saved Files Into ASCII Format 

Nicolet provides the software to convert the WFT formatted files saved by the Autocycle 
selection into an ASCII format.  Figure 33 shows the steps to follow when opening the 
Waveform Conversion software and also the folder C;\EXP\00000087, where the Autocycle files 
were saved by default.  Figure 34 shows these files converted into an ASCII float format, with 
the appendix FLT. 
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Figure 29.  Recalled channel 1 (CH1) sp001.wft file from Scope 1 saved 

transferred data. 

 
Figure 30.  Recalled channel 3 (CH3) sp001.wft file from Scope 1 saved 

transferred data. 

3. Acquisition of Experimental Data 

A detailed description of sampling rates available on the Integra 10 oscilloscopes is shown in 
table 1.  It is important to determine the time span needed to acquire data for each channel and 
then group the channels of compatible window length or same time per point setting on the same  
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Figure 31. Selecting files to recall from Scope 2 folder. 

 
Figure 32.  Recalled channel 4 (CH4) sp001.wft file from scope 2 saved 

transferred data. 

 
Figure 33.  Steps to convert WFT files to ASCII format. 
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Figure 34.  WFT files converted into ASCII float format. 

Table 1.  Integra 10 sampling rates.  

Sweep Length Menu 
500 

(3 KB per WFT file) 
1000 

(4 KB per WFT File) 
2000 

(6 KB per WFT file) 
5000 

(12 KB per WFT  file) 
10000 

(22 KB per WFT file) 
Available Sampling Rate  

(s/pt) 

∆ cursor: 
 1 × s/pt 

 

Total 
Sweep 
Time 

M = 1/10 
∆ cursor 
2 × s/pt  

Total 
Sweep 
Time 

M = 1/10 
∆ cursor: 
4 × s/pt   

Total 
Sweep 
Time 

M = 1/10 
∆ cursor: 
10 × s/pt  

Total 
Sweep 
Time 

M = 1/10 
∆ cursor: 
20 × s/pt  

Total 
Sweep 
Time 

M = 1/10 
1.0 µs 500 µs 1.0 µs 1 ms 1.0 µs 2 ms 1.0 µs 5 ms 1.0 µs 10 ms 
2.0 µs 1 ms 2.0 µs 2 ms 2.5 µs 5 ms 2.0 µs 10 ms 2.0 µs 20 ms 
4.0 µs 2 ms 5.0 µs 5 ms 5.0 µs 10 ms 4.0 µs 20 ms 5.0 µs 50 ms 
10 µs 5 ms 10 µs 10 ms 10 µs 20 ms 10 µs 50 ms 10 µs 100 ms 
20 µs 10 ms 20 µs 20 ms 25 µs 50 ms 20 µs 100 ms 20 µs 200 ms 
40 µs 20 ms 50 µs 50 ms 50 µs 100 ms 40 µs 200 ms 50 µs 500 ms 

100 µs 50 ms 100 µs 100 ms 100 µs 200 ms 100 µs 500 ms 100 µs 1 s 
200 µs 100 ms 200 µs 200 ms 250 µs 500 ms 200 µs 1 s 200 µs 2 s 
400 µs 200 ms 500 µs 500 ms 500 µs 1 s 400 µs 2 s 500 µs 5 s 
1.0 ms 500 ms 1.0 ms 1 s 1.0 ms 2 s 1.0 ms 5 s 1. 0 ms 10 s 
2.0 ms 1 s 2.0 ms 2 s 2.5 ms 5 s 2.0 ms 10 s 2.0 ms 20 s 
4.0 ms 2 s 5.0 ms 5 s 5.0 ms 10 s 4.0 ms 20 s 5.0 ms 50 s 
10 ms 5 s 10 ms 10 s 10 ms 20 s 10 ms 100 s 10 ms 100 s 
20 ms 10 s 20 ms 20 s 25 ms 50 s 20 ms 200 s 20 ms 200 s 
40 ms 20 s 50 ms 50 s 50 ms 100 s 40 ms 400 s 50 ms 500 s 

100 ms 50 s 100 ms 100 s 100 ms 200 s 100 ms 500 s 100 ms 1 ks 
200 ms 100 s 200 ms 200 s 250 ms 500 s 200 ms 1 ks 200 ms 2 ks 
400 ms 200 s 500 ms 500 s 500 ms 1 ks 400 ms 2 ks — — 

1.0 s 500 s 1.0 s 1 s 1.0 s 2 ks  — — — — 
2.0 s 1 s 2.0 s 2 s — — — — — — 
4.0 s 2 s — — — — — — — — 
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oscilloscope.  The time display2 on the right side of the Integra 10 (figure 6) will switch different 
available sampling rates through the Zoom knob. 

These sampling rates are shown in table 1 and accessed in the Integra 10 by sequentially pressing 
the Main Under Menu and Sweep Length Menu buttons.  Five choices are displayed for the 
number of data points—500, 1000, 2000, 5000, and 10000.  Under each of these categories  
(table 1), the sample per point (s/pt) is shown together with the cursor increment, the total sweep 
time, and the length of the scope display (M), which is always 1/10 of the total sweep time.  

As previously shown, settings for the View display on Proview has to be loaded by recalling or 
creating a proper set of parameters compatible with the characteristics of the data (figure 35).  

The icon for the Integra Control has to be enabled and its link to the oscilloscope(s) checked out 
by prompting a “Ready to Trigger” test on the scope (figure 36).  

The amplitude desired for the signal display is selected through the Trace Setup option  
(figure 37) as well as the window length for transferred data display (figure 38).  Figures 39 and 
40 show transferred static blast overpressure data from gauges 1–8 distributed throughout the 
blast field.  Figure 41 shows transferred data into View as breech pressure (trace_TR1H10K), 
muzzle pressure (trace_TR2H10K), and Laser Doppler Velocity Transducer or LDVT 
(trace _TR3H10K).  

 

Figure 35.  Loading channel setups for experiment. 

                                                 
2 Nicolet Instruments Technologies Inc. Integra Series Operation Manual; Madison, WI. 
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Figure 36.  Setting laptop Proview window and Integra Control menu. 

 

Figure 37.  Setting volts per division as required to view full range 
of data. 

 

Figure 38.  Setting proper window length to view acquired data. 
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Figure 39.  Scope 1 data from gauges 1, 2, 3, and 4. 

 

Figure 40.  Scope 2 data from gauges 5, 6, 7, and 8. 
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Figure 41.  Scope 3 breech pressure gauge, muzzle gauge, and Doppler velocity data. 

4. Conclusion 

As the user develops familiarity with the Proview and Integra Control menus and the setting of 
the oscilloscopes for a ready-to-trigger status as well as the transfer and saving of data through 
Windows onto the laptop, the probability of losing data files due to floppy disks issues is 
eliminated.  The operation becomes less time consuming, less intensive, and less prone to 
mistakes due to data lost or corrupted caused by insufficient floppy disk space for data storage 
when saving it on the scope.  The software proved to be very reliable, without glitches, and 
worked well on all tests performed.
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 1 DEFENSE TECHNICAL 
 (PDF INFORMATION CTR 
 Only) DTIC OCA 
  8725 JOHN J KINGMAN RD 
  STE 0944 
  FT BELVOIR VA 22060-6218 
 
 1 COMMANDING GENERAL 
  US ARMY MATERIEL CMD 
  AMCRDA TF 
  5001 EISENHOWER AVE 
  ALEXANDRIA VA 22333-0001 
 
 1 INST FOR ADVNCD TCHNLGY 
  THE UNIV OF TEXAS  
  AT AUSTIN 
  3925 W BRAKER LN STE 400 
  AUSTIN TX 78759-5316 
 
 1 US MILITARY ACADEMY 
  MATH SCI CTR EXCELLENCE 
  MADN MATH 
  THAYER HALL 
  WEST POINT NY 10996-1786 
 
 1 DIRECTOR 
  US ARMY RESEARCH LAB 
  AMSRD ARL CS IS R 
  2800 POWDER MILL RD 
  ADELPHI MD 20783-1197 
 
 3 DIRECTOR 
  US ARMY RESEARCH LAB 
  AMSRD ARL CI OK TL 
  2800 POWDER MILL RD 
  ADELPHI MD 20783-1197 
 
 3 DIRECTOR 
  US ARMY RESEARCH LAB 
  AMSRD ARL CS IS T 
  2800 POWDER MILL RD 
  ADELPHI MD 20783-1197 

ABERDEEN PROVING GROUND 
 
 1 DIR USARL 
  AMSRD ARL CI OK TP (BLDG 4600) 
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 ABERDEEN PROVING GROUND 
 
 25 DIR USARL
  AMSRD ARL WM B 
   A HORST 
  AMSRD ARL WM BC 
   M DEL GÜERCIO 
   J GARNER 
   R KEPPINGER 
   T PUCKETT 
   B GUIDOS 
   C PAXTON 
   K PAXTON 
   P PLOSTINS 
   S SILTON 
   K THOMPSON 
   J TUERK 
   K WILLAN 
   A ZIELINSKI 
  AMSRD ARL WM BD 
   J COLBURN 
   B FORCH 
  AMSRD ARL WM BM 
   R BEYER 
  AMSRD ARL WM EG 
   E SCHMIDT 
  AMSRD ARL WM TC 
   R COATES 
   B SORENSEN 
  AMSRD ARL WM TE 
   M MCNEIR 
   T KOTTKE 
  AMSRD ARL WM BA 
   D LYON 
   B PATTON 
   G KATULKA 


